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Dig deeper. Explore your MacBook Air and get your questions answered. See
.

Take a tour
The 13-inch MacBook Air with Retina Display has the following features built in:

Thunderbolt 3 (USB-C) ports: Charge your computer, transfer data at Thunderbolt
speeds (up to 40 Gbps), connect to a display or projector, and more.

3.5 mm headphone jack: Plug in stereo headphones or external speakers to listen to
your favorite music or movies.

FaceTime HD camera: Make FaceTime video calls or take pictures and video. If the
light is glowing, the camera is on. For more information, see .

Touch ID (power button): Press to turn on your MacBook Air (or just lift the lid). When
you first start up or restart, you need to log in by typing your password. After you set
up Touch ID, you can authenticate with a touch instead of typing your password (after
your first login), and use Touch ID for Apple Pay purchases. For more information, see

.

macOS User Guide

FaceTime

Keyboard
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Microphones: Talk with friends or record audio with multiple built-in microphones.

Force Touch trackpad: Control your MacBook Air with gestures. The entire trackpad
surface acts as a button so you can easily click anywhere. For more about using
gestures, see .

Whatʼs included
To use your MacBook Air, you need these two accessories, included in the box:

USB-C Charge Cable (2 m): Connect one end to your
MacBook Air and the other end to the USB-C Power Adapter.

30W USB-C Power Adapter: To charge your MacBook Air, fully
extend the electrical prongs on the AC plug, and plug the
adapter into an AC power outlet.

Adapters and other accessories are sold separately at  or your local
Apple Store. Be sure to review the adapter or accessory documentation to make sure
youʼre choosing the right product for your MacBook Air.

Keyboard
The function keys on the keyboard provide shortcuts for common functions, such as
increasing the volume or screen brightness.

Trackpad

apple.com
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Touch ID (power button): Press to turn on your MacBook Air (or just lift the lid). When
you first start up or restart, you need to log in by typing your password. You set up
Touch ID during setup or later in the Touch ID pane of System Preferences. After
setup, whenever youʼre asked for your password after you first log in, you can place
your finger lightly on the Touch ID sensor to authenticate instead of typing your
password.

You can also use Touch ID to make purchases online securely with Apple Pay. For
more information about Touch ID, see . For more information about Apple Pay,
see .

Note: Press and hold the Touch ID sensor (power button) for a few seconds to turn off
your MacBook Air. To put your MacBook Air to sleep, choose Apple menu  > Sleep.

Brightness keys (F1, F2): Press  or  to decrease or increase the brightness of the
screen.

Mission Control key (F3): Press  to view whatʼs running on your MacBook Air,
including all your spaces and open windows.

Launchpad key (F4): Press  to instantly see all the apps on your MacBook Air. Click
an app to open it.

Keyboard illumination keys (F5, F6): Press  or  to decrease or increase the
brightness of the keyboard.

Media keys (F7, F8, F9): Press  to rewind,  to play or pause, or  to fast-
forward a song, movie, or slideshow.

Mute key (F10): Press  to mute the sound from the built-in speakers or 3.5 mm
headphone jack.

Set up
Apple Pay
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Volume keys (F11, F12): Press  or  to decrease or increase the volume of sound
from the built-in speakers or 3.5 mm headphone jack.

Function (Fn) key: Each function key (on the top row) can also perform other
functions—for example, the F12 key can open Dashboard. Hold down the Fn key while
you press a function key to trigger the action associated with the key.

Tip: Press the Fn key twice to turn on dictation, which lets you dictate text wherever
you can type it (for example, in Messages, Mail, Pages, and many other apps).

Set keyboard preferences. Use the Keyboard pane of System Preferences (choose
Apple menu  > System Preferences, click Keyboard, then click the buttons at the top to
see the available options).

Trackpad
You can do a lot on your MacBook Air using simple trackpad gestures—scroll through
webpages, zoom in on documents, rotate photos, and more. With the Force Touch
trackpad, pressure-sensing capabilities add another level of interactivity. The trackpad
provides feedback—when you drag or rotate objects, you feel a subtle vibration when
theyʼre aligned, allowing you to work with greater precision.

Here are some common gestures:

Draft Apple proprietary and confidential
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For more information and examples of force click options, see the Apple Support article
.

Charge the battery
The battery in your MacBook Air recharges whenever the MacBook Air is connected to
power.

Charge the battery. Connect your MacBook Air to a power outlet using the included
USB-C Charge Cable and 30W USB-C Power Adapter.

You can charge your MacBook Air using either of the Thunderbolt 3 ports on your
computer. The battery charges more quickly when the computer is off or in sleep.

Check the batteryʼs charge. Look at the battery status icon at the right of the menu bar
to see the battery level or charging status.

Conserve battery power. To extend battery life on a given charge, you can reduce the
display brightness, close apps, and disconnect peripheral devices youʼre not using. You
can change your power settings in Energy Saver preferences (click the System
Preferences icon  in the Dock, then click Energy Saver). If your MacBook Air is in sleep
when a device is connected to it, the deviceʼs battery may drain.

For more information about the internal, rechargeable battery in your MacBook Air, and
for conservation and performance tips, go to .

How to use the Force Touch trackpad

Apple Lithium-ion Batteries
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Connect a VGA display or projector: Use a USB-C VGA Multiport Adapter to connect
the display to the USB-C port on your MacBook Air.

Connect an HDMI display or HDTV: Use a USB-C Digital AV Multiport Adapter to
connect the HDMI display or HDTV to the USB-C port on your MacBook Air.

Connect a USB-C display: Connect the display to the USB-C port on your
MacBook Air.

Connect a Thunderbolt display: Use a Thunderbolt 3 (USB-C) to Thunderbolt 2
Adapter to connect the Thunderbolt display to a Thunderbolt 3 port on your
MacBook Air.

Adapters and other accessories are sold separately at  or your local
Apple Store. Review the documentation or check with the manufacturer to make sure you
choose the right adapter.

If you have an HDTV connected to an Apple TV, you can also use AirPlay to mirror your
MacBook Air screen on your TV screen in up to 1080p HD. See  for details.

apple.com

AirPlay
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Tip: If you donʼt see the Wi-Fi status icon  or Bluetooth icon  in the menu bar, you
can add them. For Wi-Fi, choose Apple menu  > System Preferences, then click
Network. Click Wi-Fi in the list on the left, then select “Show Wi-Fi status in menu bar.”
For Bluetooth, choose Apple menu  > System Preferences, click Bluetooth, then select
“Show Bluetooth in menu bar.”

Set up “Hey Siri.” On your MacBook Air, you can simply say “Hey Siri” to get responses
to your requests. To enable this feature in the Siri pane of System Preferences, click
“Listen for ‘Hey Siri ,̓” then speak several Siri commands when prompted.

Get an Apple ID. Your Apple ID is the account you use for everything you do with Apple—
including using the App Store, the iTunes Store, iCloud, Messages, and more. Your
Apple ID consists of an email address and a password. You need only one Apple ID to use
any Apple service, on any device—whether itʼs your computer, iOS device, or
Apple Watch. Itʼs best to have your own Apple ID and not share it—create separate
Apple IDs for each family member.

If you donʼt already have an Apple ID, you can create one (itʼs free). Go to 
.

Important: If you forget your Apple ID password, you donʼt need to create a new
Apple ID. Just click the Forgot link in the login window to retrieve your password.

Set up iCloud on your MacBook Air. With iCloud, you can store all of your content—
documents, movies, music, photos, and more—in the cloud, and access it anywhere you
go.

To set up iCloud, choose Apple menu  > System Preferences, then click iCloud. In the
window that appears, enter your Apple ID and password. Then select the features you
want to use. To find out more, see .

Important: Be sure to use the same Apple ID for iCloud on all your devices.

Set up Siri. You can enable Siri on your MacBook Air when prompted during setup. To
learn how to turn on Siri later and for information about using Siri on your Mac, see .

Set up Touch ID. With your MacBook Air, you can add a fingerprint to Touch ID during
setup. To set up Touch ID later or to add additional fingerprints, click the System
Preferences icon  in the Dock, or choose Apple menu  > System Preferences. Then
click Touch ID. To add a fingerprint, click  and follow the onscreen instructions. You can
add up to three fingerprints per user account, and a total of five fingerprints for all
MacBook Air user accounts.

the Apple ID
account website

Access your content anywhere with iCloud

Siri
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Find your way around

The desktop, menu bar, and Help
The first thing you see on your MacBook Air is the desktop, where you can quickly open
apps, search for anything on your MacBook Air and the web, organize your files, and
more.

Tip: Canʼt find the pointer? To magnify it temporarily, move your finger rapidly back
and forth on the trackpad. Or if youʼre using a mouse, slide it back and forth quickly.

Menu bar. Use the menus and icons along the top of the screen to open new windows,
connect to a Wi-Fi network, check your Wi-Fi status , change the volume , check
your battery charge , query Siri, and more. The menu items change, depending on
which app youʼre using.

Apple menu . The Apple menu in the upper-left corner of the screen contains
frequently used items. To open it, click the Apple icon .

Help menu. Help for your MacBook Air and macOS apps is always available from the
Finder. To get help, click the Help menu and choose macOS Help to open the macOS
User Guide. Or type in the search field and choose a suggestion.
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Gallery View. With Gallery View, you can see a large preview of your selected file, which
gives you a quick way to visually identify images, video clips, and other documents. The
Preview pane shows information to help you identify the file you want. Use the scrubber
bar at the bottom to quickly locate what youʼre looking for.

Quick Actions. At the bottom right of the Preview pane are shortcuts that let you
manage and edit files right in the Finder. You can rotate an image, annotate or crop an
image in Markup, combine images and PDFs into a single file, trim audio and video files,
and create custom actions through Automator workflows (for example, watermarking a
file).

To show the Preview pane options in the Finder, choose View > Show Preview. To
customize whatʼs shown, choose View > Show Preview Options, then select the options
for your file type. For more information about Quick Actions, see 

 in the macOS User Guide.

The Dock
The Dock, at the bottom of the screen, is a convenient place to keep the apps and
documents you use frequently.

Perform quick actions in
the Finder on Mac
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Open an app or file. Click its icon in the Dock. Recently opened apps appear in the
center section of the Dock.

Add an item to the Dock. Drag the item and drop it where you want it. Place apps in the
left section of the Dock, and files or folders in the right section.

Remove an item from the Dock. Drag it out of the Dock. The item isnʼt removed from
your MacBook Air—just from the Dock.

See all open windows in an app. Force click an app in the Dock to access Exposé and
view all the appʼs open windows.

Tip: You can make the Dock larger or smaller, add or remove items, move it to the left
or right side of the screen, or even set it to hide when youʼre not using it. To change how
the Dock looks, click the System Preferences icon  in the Dock, or choose
Apple menu  > System Preferences. Then click Dock.

Quickly open apps
Your MacBook Air comes with apps for all the things you love to do—browse the web,
check email, share photos, enjoy movies, and more.

Open an app. Click an app icon in the Dock, or click the Launchpad icon  in the Dock
and click the app you want. You can also search for an app using Spotlight, then open the
app directly from your Spotlight search results.
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“What time is it in Paris?”
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Whatʼs new

New macOS features
macOS Mojave offers many exciting new features, including:

Dark Mode: Use a dark color scheme for the Desktop, menu bar, Dock, and all the
built-in apps on macOS. Your content stands out front and center while darkened
controls and windows recede into the background. For more information, see 

.

Desktop: The default desktop background adjusts to match the time of day in your
time zone. And you can use stacks to automatically organize files on your desktop by
file type, kind, date, or tag. For more information, see 

.

Finder: Large previews let you view and quickly locate files in the new Gallery View.
Use the Preview pane to view all of a fileʼs metadata. Perform basic edits like rotating
images and creating PDFs in the Finder with Quick Actions. For more information, see

.

Quick Look: Select a file and press the Space bar to open Quick Look. You can sign
PDFs; trim audio and video files; and mark up, rotate, and crop images without
opening a separate app. To learn more about Quick Look and markup features, see

 and  in the macOS
User Guide.

Screenshot utility: The easy-to-use menu lets you take screenshots and screen
recordings that can include your voice. You can also set a start timer, show the
cursor, and customize where to save your screenshots. A new workflow makes it
easier to save, edit, and share what you capture. For more information, see

.

Continuity Camera: Use your iPhone or iPad camera to insert an image directly within
a document on your Mac, or save it as a file in the Finder. You can also scan a
document using your iOS device and save it to your Mac as a PDF file. For more
information, see .

FaceTime: FaceTime now provides more options for joining a call and switching
between audio and video. For more information, see .

Dark
Mode

The desktop, menu bar, and
Help

The Finder

View and edit files with Quick Look on Mac Mark up files on Mac

Screenshot utility

Continuity Camera

FaceTime
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App Store: A redesigned sidebar in the App Store makes it easier for you to browse,
search, and filter apps. Read in-depth stories and explore curated collections on the
Discover tab. For more information, see .

Security and Privacy: Your Mac asks for permission before granting apps access to a
wide range of tools and personal data. Enhanced privacy protections in Safari make it
harder for data companies to track your web browsing. Safari also automatically
suggests and stores unique, strong passwords when you sign up for an account, and
identifies passwords that have been reused so you can easily change them. For more
information, see .

Additionally, macOS Mojave brings four new apps to Mac:

Apple News: Browse trusted news and information that's been curated by editors and
personalized for you. You can save articles for future reading—even offline or on
other devices. For more information, see .

Stocks: Customize your watchlist to follow stocks, indexes, currencies, and more.
View prices and interactive charts, and read high-quality business news right in the
app. For more information, see .

Voice Memos: Record and edit audio clips on your Mac. Sync and listen to recordings
on all your devices using iCloud. For more information, see .

Home: Control your HomeKit accessories using your Mac. The Home app lets you
automate accessories; create scenes, which allow accessories to work together with
a single command; and get real-time notifications if something happens in your home.
You can also use Siri to control accessories when the app isnʼt running. For more
information, see .

Dark Mode
Dark Mode transforms your desktop picture, menu bar, Dock, and built-in apps to a dark
color scheme. It makes your content stand out while darkened controls and windows
recede into the background, so itʼs easier to stay focused on your work.

Perfect for pros. Dark Mode is finely tuned for professionals who edit photos and
images—colors and fine details pop against the dark app backgrounds. But itʼs also great
for anyone who just wants to focus on their content.

Easy on your eyes. In Dark Mode, macOS shows white text on a black background in
apps such as Mail, Contacts, Calendar, and Messages, so itʼs easier on your eyes when
youʼre working in dark environments.

App Store

Safari

Apple News

Stocks

Voice Memos

Home
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Beautiful new look. Dark Mode is a great way to give your Mac a new look that makes
your content shine in apps like Photos, iTunes, Messages, and Keynote. Itʼs been
integrated throughout macOS and its apps, so you can stay fully immersed in your work.

Learn more. To learn more about Dark Mode, see 
 in the macOS User Guide.

“Hey Siri” on your Mac
On your MacBook Air, Siri is now available whenever you say “Hey Siri” and immediately
speak your request (your MacBook Air lid must be open). Play music, set up a meeting,
open a file, and more by using your voice. You can enable the “Listen for ‘Hey Siriʼ”
option in the Siri pane of System Preferences. For more information, see .

Screenshot utility
Explore the Screenshot menu to find all the controls you need to take screenshots and
screen recordings. You can also capture your voice during a screen recording. The
optimized workflow lets you take photos and videos of your screen, and then easily
share, edit, or save them.

Access the screenshot controls. Press Command-Shift-5. You can capture the entire
screen, a selected window, or a portion of a window. You can also record the entire
screen or a selected portion of the screen.

Use the icons at the bottom of the screen to capture a selection , record your screen 
, and more. Click Options to save the screenshot, set a timer before capturing, set

microphone and audio options, or show elements like the pointer. Click Capture to save

Use a light or dark appearance on your
Mac

Siri

Draft Apple proprietary and confidential
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back up the contents of your computer. For more information, see 
 in macOS Help and the Apple Support article 

.

Secure boot and Startup Security Utility: Support for secure boot is on automatically.
It helps ensure that only legitimate operating system software loads on your
computer at startup.

If your MacBook Air doesnʼt start because it detects an untrusted component, it will
start up from a secure recovery partition and automatically correct issues if possible.
To learn more about the Startup Security Utility or to find out how to set other
options, such as starting up from an external device, see the Apple Support article

.

Migrate your data
Itʼs easy to move your files and settings from another Mac or PC to your MacBook Air.
You can transfer information to your MacBook Air from an old computer—or from a Time
Machine backup on a USB storage device—either wirelessly, or with an Ethernet cable
and adapters.

Tip: For best results, make sure your MacBook Air is running the latest version of
macOS. To check for software updates, click the App Store icon  in the Dock, then click
Updates in the App Store toolbar.

Transfer wirelessly. To transfer the data when you first set up your MacBook Air, use
Setup Assistant. To transfer data later, you can use Migration Assistant. Open a Finder
window, go to Applications > Utilities, then double-click Migration Assistant to do a
wireless migration. Follow the onscreen instructions.

Back up your files
with Time Machine How to use Time
Machine to back up or restore your Mac

About Startup Security Utility
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Tip: To transfer the information wirelessly from your old computer to your
MacBook Air, make sure both computers are connected to the same network. Keep both
computers near each other throughout the migration process.

If you used Time Machine to back up your files from another Mac to a storage device
(such as an external disk), you can copy the files from the device to your MacBook Air.
For more information about Time Machine backups, see .

Copy files from a USB storage device. Connect the storage device to your MacBook Air
using a USB-C to USB Adapter (see ). Then drag files from your storage
device to your MacBook Air.

Transfer using Ethernet. To transfer your data over Ethernet, use an adapter (available
separately) to connect the Ethernet cable to your MacBook Air. Connect the other end of
the Ethernet cable to your other computer (you might need another adapter, if your
computer doesnʼt have an Ethernet port). Before transferring your data using Ethernet,
make sure your MacBook Air battery is fully charged.

For complete details about all the migration methods, see the Apple Support article 
.

Save space on your MacBook Air
With Optimize Storage, you can automatically free up space on your MacBook Air by
making files available on demand. Your files will be stored in iCloud Drive, iCloud Photos
(formerly called iCloud Photo Library), iCloud, and iTunes, as well as on your email IMAP
or Exchange server, so you can download them at any time. In addition, there are tools to
identify and delete big files.

Optimize storage. Go to Apple menu  > About This Mac, click Storage, then click
Manage to see different storage recommendations. You see different recommendations
based on how you configured your Mac. When your Mac is low on storage, youʼll see an
alert with a link to the Storage pane.

Back up and restore

Accessories

How
to move your content to a new Mac
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Mail: Choose to have Mail download only recent email attachments, or none at all.
If you choose to download only recent attachments, your oldest email
attachments are still available on demand.

Empty Trash Automatically: Automatically erase items that have been in the Trash for
more than 30 days.

Reduce Clutter: Easily identify large files, and delete the files you no longer need. To
browse large files, click through the categories in the sidebar—Documents,
Applications, Music Creation, iOS Files, and more.

To help you save space as you work, macOS also:

Prevents you from downloading the same file twice from Safari

Alerts you to remove installer software when you finish installing a new app

Clears logs and caches that are safe to remove when youʼre low on storage

Back up and restore
To keep your files safe, itʼs important to back up your MacBook Air regularly. The easiest
way to back up is to use Time Machine—which is built into your MacBook Air—with an
external storage device connected to your MacBook Air. Time Machine can also back up
your Mac contents to supported network volumes. For a list of devices supported by
Time Machine, see the Apple Support article 

.

Files stored in iCloud Drive and photos in iCloud Photos are automatically backed up to
iCloud and donʼt need to be part of your Time Machine or other backup.

Tip: You can use a shared Mac thatʼs on the same network as your MacBook Air as a
backup destination. On the other Mac, go to System Preferences > Sharing, then turn on
File Sharing. Add a shared folder, secondary click (that is, right-click) the folder, choose
Advanced Options, then click “Share as Time Machine backup destination.”

Set up Time Machine. Make sure your MacBook Air is on the same Wi-Fi network as
your external storage device, or connect your external storage device to your
MacBook Air. Click the System Preferences icon  in the Dock, click Time Machine, then
select Back Up Automatically. Select the drive you want to use for backup, and youʼre all
set.

Backup disks you can use with Time
Machine
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Use your MacBook Air with iCloud and Continuity
features
There are many ways to use your MacBook Air with your other devices, such as iPhone,
iPad, iPod touch, or Apple Watch. You can transfer files, share and edit documents,
unlock your MacBook Air with your Apple Watch, turn your iPhone or iPad into an Internet
hotspot, answer calls or send texts from your MacBook Air, and more.

Access your content across devices. With iCloud, you can securely store, edit, and
share your documents, photos, and videos across devices to make sure youʼre always up
to date. To get started, see .

To sign in to iCloud if you didnʼt when you set up your Mac, click the System Preferences
icon  in the Dock, click iCloud, then sign in with your Apple ID, or create a new one if
you donʼt have one. To learn more, see  in the macOS User Guide.

Use your MacBook Air with other devices. You can seamlessly move between your
MacBook Air and other devices using Continuity. Just sign in to iCloud with your Apple ID,
and whenever your MacBook Air and devices are near each other, they work together in
great ways. With Continuity features, you can do things like start a task on one device
and finish it on another (see ), copy and paste between devices (see 

), answer calls or send texts from your MacBook Air (see 
), transfer files with AirDrop (see ), and more.

For a list of system requirements for devices that support Continuity, see the
Apple Support article . To learn more about using
Continuity with your MacBook Air, see the Apple Support article 

 or go to .

Use MacBook Air with other devices

Access your content anywhere with iCloud

Set up iCloud

Handoff Universal
Clipboard Phone calls and text
messages AirDrop

System requirements for Continuity
Use Continuity to

connect your Mac, iPhone, iPad, iPod touch, and Apple Watch All your devices
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Learn more. To learn more about iCloud, see  in the macOS User Guide.

Handoff
With Handoff, you can continue on one device where you left off on another. Work on a
presentation on your MacBook Air, then continue on your iPad. Or start an email message
on your iPhone, then finish it on your MacBook Air. View a message on your Apple Watch,
and respond to it on your MacBook Air. You donʼt have to worry about transferring files.
When your MacBook Air and devices are near each other, an icon appears in the Dock
whenever an activity can be handed off; to continue, just click the icon.

Turn on Handoff on your MacBook Air. Click the System Preferences icon  in the
Dock, click General, then select “Allow Handoff between this Mac and your iCloud
devices.”

Turn on Handoff on your iOS device. Go to Settings > General > Handoff, then tap to
turn on Handoff. If you donʼt see the option, your iOS device doesnʼt support Handoff.

Turn on Handoff on your Apple Watch. In the Apple Watch app on iPhone, go to
Settings > General, then tap to turn on Enable Handoff.

Note: To use Handoff, you need an iPhone, iPad, or iPod touch with the Lightning
connector and iOS 8 (or later) installed. Make sure your MacBook Air and iOS device have
Wi-Fi and Bluetooth turned on and are logged in with the same Apple ID.

Handoff works with Safari, Mail, Calendar, Contacts, Maps, Messages, Notes, Reminders,
Keynote, Numbers, and Pages.

Learn more. To learn more about Handoff, see  in
the macOS User Guide.

What is iCloud?

Pick up where you left off with Handoff
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Universal Clipboard
Copy content from one device, and paste it into another nearby device within a short
period of time. The contents of your clipboard are sent over Wi-Fi and made available to
all Mac and iOS devices that are logged in with the same Apple ID and have Handoff, Wi-
Fi, and Bluetooth turned on. For more information, see .

Note: To use Universal Clipboard, you need an iPhone, iPad, or iPod touch with the
Lightning connector and iOS 10 (or later) installed.

Use across apps. You can copy and paste images, text, photos, and video between any
apps that support copy and paste on your Mac, iPhone, iPad, and iPod touch.

Copy and paste files. You can quickly move files from one Mac to another using
Universal Clipboard. Copy a file on your MacBook Air and paste it into a Finder window,
Mail message, or any app that supports copy and paste on a nearby Mac. You must be
signed in with the same Apple ID on both Macs.

Learn more. To learn more about Universal Clipboard, see 
 in the macOS User Guide.

Continuity Camera
You can use your iPhone or iPad to take a scan or a photo of something nearby and insert
it into a document on your Mac. Scan a document or take a picture of something with
your iPhone or iPad camera, and it appears where you want it on your Mac.

Insert an image. In an app like Mail, Notes, or Messages, select where you want the
image to go, choose File > Import From iPhone or iPad, choose “Take Photo or Scan
Documents”, then take the photo or scan the image on your iOS device. You might need
to select your iOS device before taking the photo. Tap Use Photo or Keep Scan. You can
also tap Retake if you want to try again.

Handoff

Copy and paste across
devices from your Mac
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When you send a file to someone, the recipient can choose whether or not to accept the
file. When someone sends you a file, you can find it in the Downloads folder on your
MacBook Air.

Tip: If you donʼt see the recipient in the AirDrop window, make sure both devices
have AirDrop and Bluetooth turned on and are within 30 feet (9 meters) of each other. If
the recipient is using an older Mac, try clicking the “Donʼt see who youʼre looking for?”
link.

Learn more. To learn more about AirDrop, see 
 in the macOS User Guide.

Phone calls and text messages
You can take calls—and make them—right from your MacBook Air. You can also receive
and send text messages.

Note: A Wi-Fi connection is required in order to make or receive phone calls on your
MacBook Air.

Take or make a call. When someone calls your iPhone, click the notification that appears
on your MacBook Air screen. Your MacBook Air becomes a speakerphone. If you want to
make a call, click a phone number in a Spotlight search or in an app such as FaceTime,
Contacts, Safari, or Calendar. You need a nearby device (iPhone or iPad) with a cellular
connection in order to make phone calls.

Send and receive messages. Send and receive SMS and MMS text messages right from
your MacBook Air. When friends and family text you, you can respond with whichever
device is closest. All messages appear on your MacBook Air, iPhone, iPad, iPod touch,
and Apple Watch. For more information, see .

Use AirDrop on your Mac to send files to
devices near you

Messages
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Learn more. To learn more about phone calls and text messages, see 
 in the FaceTime User Guide and 

 in the Messages User Guide.

Instant Hotspot
Lost your Wi-Fi connection? Use the Personal Hotspot on your iPhone or iPad to connect
your MacBook Air to the Internet.

Note: Personal Hotspot requires an iPhone or cellular model iPad, with iOS 8 or later.

Connect to your deviceʼs Personal Hotspot. Click the Wi-Fi status icon  i​n the menu
bar, then choose your iPhone or iPad in the list of devices that appears. (You donʼt need
to do anything on your device—MacBook Air connects automatically.)

Check the status of your connection. Look in the Wi-Fi status menu to see the strength
of the cellular signal.

When youʼre not using the hotspot, your MacBook Air disconnects to save battery life.

Learn more. To learn more about using Instant Hotspot, see 
 in the macOS User Guide.

Make and receive
phone calls in FaceTime on Mac Set up iPhone to get
SMS texts on Mac

Use an iPhone or iPad to
connect to the Internet
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AirPlay
Show whateverʼs on your MacBook Air on the big screen using AirPlay Mirroring. To
mirror the MacBook Air screen on your TV screen or to use the HDTV as a second
display, connect your HDTV to Apple TV and make sure the Apple TV is on the same Wi-
Fi network as your MacBook Air. You can also play web videos directly on your HDTV
without showing whatʼs on your desktop—handy when you want to play a movie but keep
your work private.

Mirror your desktop using AirPlay Mirroring. Click the AirPlay icon  in the menu bar,
then choose your Apple TV. When an AirPlay display is active, the icon turns blue.

In some cases, you can use an AirPlay display even if your MacBook Air isnʼt on the same
Wi-Fi network as Apple TV (called peer-to-peer AirPlay). To use peer-to-peer AirPlay, you
need an Apple TV (3rd generation rev A, model A1469 or later) with Apple TV software
7.0 or later.

Play web videos without showing your desktop. When you find a web video with an
AirPlay icon , click the icon, then select your Apple TV.

Tip: If the image doesnʼt fit your HDTV screen when you mirror the screen, adjust the
desktop size for the best picture. Click the AirPlay icon , then choose an option under
“Match Desktop Size To.”

Apple TV is sold separately at  or your local Apple Store.

Learn more. To learn more about AirPlay, see 
 in the macOS User Guide. To learn more about using a second display with

your MacBook Air, see .

apple.com

Use AirPlay to stream what's on your Mac
to an HDTV

Use an external display
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AirPrint
You can use AirPrint to print wirelessly to:

An AirPrint-enabled printer on your Wi-Fi network

A network printer or printer shared by another Mac on your Wi-Fi network

A printer connected to the USB port of an AirPort base station

Print to an AirPrint printer. When you print from an app, click the Printer pop-up menu
in the Print dialog, then choose a printer in the Nearby Printers list.

Canʼt find the printer youʼre looking for? Make sure itʼs connected to the same Wi-Fi
network as your MacBook Air. If itʼs connected and you still donʼt see it, try adding it:
Click the System Preferences icon  in the Dock, click Printers & Scanners, then click
Add . (You may have to temporarily connect the printer to your MacBook Air using a
USB cable with an adapter, if necessary.)

Learn more. To learn more about AirPrint, see 
 in the macOS User Guide.

For a list of AirPrint-enabled printers and other supported printers, see the Apple Support
articles  and .

Print wirelessly from your Mac to an
AirPrint printer

About AirPrint Printer and scanner software available for macOS
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Bring in the beat. You can quickly add drums to your project using Drummer Loops.
Click the Loop Browser , then drag a Drummer Loop  into an empty part of the Tracks
area. You can customize Drummer Loops to fit your song, using a simple set of controls.

Record your voice. Choose Track > New Track, then select the microphone under Audio.
Click the triangle next to Details to set options for input, output, and monitoring, then
click Create. Click the Record button  to start recording, or the Play button  to stop
recording.

Learn more. To learn more about GarageBand, see .GarageBand Support
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Record video with the built-in camera. Use the FaceTime HD camera on your Mac to
record video and add it to your project. Select an event in the sidebar, click Import in the
toolbar, then select FaceTime HD Camera. Click the Record button to start and stop
recording.

Create Hollywood-style trailers. Make clever trailers, complete with animated graphics
and soaring soundtracks. Just add photos and video clips and customize the credits. To
get started, click the New button , click Trailer, choose a template from the Trailer
window, then click Create. Add the cast and credits in the Outline tab, and add your own
photos and videos in the Storyboard tab.

Tip: Shooting video with a handheld device can produce shaky results, but you can
stabilize the video so the playback is smoother. Select the shaky clip in the timeline, click
the Stabilization button , then click Stabilize Shaky Video.

Learn more. To learn more about iMovie, see .iMovie Support
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All your formatting tools, in one place. Click the Format button  in the toolbar to
open the Format inspector. Select something in your document, and the formatting
options for it appear.

Flow text around graphics. When you add an image to a text document, the text flows
automatically around the image. You can fine-tune how the text wraps in the Format
sidebar.

Start on your Mac, finish on iPad. You can keep documents up to date across all your
devices when you sign in to iCloud with the same Apple ID. So you can start composing
on one device, and pick up where you left off on another.

Tip: Turn on change tracking to see the changes you and others make to the
document. Each personʼs edits and comments are color-coded so you can see who made
the change. Choose Edit > Turn on Tracking to show the change tracking toolbar.

Learn more. To learn more about Pages, see .Pages Support
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View multiple websites in one window. Click  at the far right of the tab bar or press
Command-T to open a new tab, then enter an address. To keep a website handy, drag its
tab left to pin it, and it stays in the tab bar.

See whatʼs open on each of your devices. You can see open webpages on all your
devices that are signed in to the same iCloud account. Just click the Show All Tabs
button  at the top of the window and scroll down if necessary.

Browse the web safely and privately. Safari warns you when you visit a website thatʼs
not secure, or that may be trying to trick you into sharing your personal data. Safari also
protects you automatically from cross-site tracking, by identifying and removing the data
that trackers leave behind. Safari asks your permission before allowing a social network
to see what youʼre doing on third-party sites. For example, if you click a Facebook button
to share an article to Facebook, Safari asks if you want to let Facebook see your activity
on the site. And Safari defends you against web tracking by making your Mac harder to
identify uniquely.

When you sign up for a new account on the web, Safari automatically creates and
autofills a new strong password for you. If you choose Use Strong Password, the
password is saved to your iCloud Keychain and will autofill on all the devices you log in to
with the same iCloud account. You can ask Siri to show you your saved passwords, which
you can see after entering the authentication password for your Mac, or go to Safari >
Preferences and then click Passwords. Reused passwords are flagged in the passwords
list, so you can easily replace them with strong passwords.
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How do I find the technical specifications? Go to {NEED LINK: MBAN Tech Specs}, or
choose Apple menu  > About This Mac and click the buttons at the top.

Ask Siri. Ask Siri for information about your Mac. Say something like:

“How fast is my Mac?”

“How much memory does my Mac have?”

“How much free space do I have on my Mac?”

“How much iCloud storage do I have left?”

How do I check my disk for problems? Use Disk Utility. See the Apple Support article
.

Keyboard shortcuts
You can press key combinations to do things on your MacBook Air that youʼd normally do
with a trackpad, mouse, or other device. Hereʼs a list of commonly used keyboard
shortcuts.

Using Disk Utility to verify or repair disks
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Shortcut Description

Command-X Cut the selected item and copy it to the Clipboard.

Command-C Copy the selected item to the Clipboard.

Command-V Paste the contents of the Clipboard into the current document or
app.

Command-Z Undo the previous command. Press Command-Shift-Z to redo.

Command-A Select all items.

Command-F Open a Find window, or find items in a document.

Command-G Find the next occurrence of the item youʼre searching for. Press
Command-Shift-G to find the previous occurrence.

Command-H Hide the windows of the front app. Press Command-Option-H to
view the front app but hide all other apps.

Command-M Minimize the front window to the Dock. Press Command-Option-
M to minimize all windows of the front app.

Command-N Open a new document or window.

Command-O Open the selected item, or open a dialog to select a file to open.

Command-P Print the current document.

Command-S Save the current document.

Command-W Close the front window. Press Command-Option-W to close all
windows of the app.

Command-Q Quit the current app.

Command-Option-Esc Choose an app to Force Quit.

Command-Tab Switch to the next most recently used app among your open
apps.

Command-Shift-5 Open the Screenshot app and then:

Press Command-Shift-3 to take a screenshot of the entire
screen.

Press Command-Shift-4 to take a screenshot of a selected
area of the screen.
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If you switched to the Mac from a PC, check out  for a list
of Mac keyboard shortcuts and the differences between Mac and Windows keyboards.
For a more complete list of keyboard shortcuts, see the Apple Support article 

.

More resources, service, and support
You can find more information about your MacBook Air in System Report, in Apple
Diagnostics, and through online resources.

System Report. To get information about your MacBook Air, use System Report. It shows
you what hardware and software is installed, the serial number and operating system
version, how much memory is installed, and more. To open System Report, choose
Apple menu  > About This Mac, then click System Report.

Apple Diagnostics. You can use Apple Diagnostics to help determine if thereʼs a problem
with one of the computerʼs components, such as the memory or processor. Apple
Diagnostics helps to identify the potential source of a hardware issue and provides first
steps to try and resolve it. Apple Diagnostics will also help you get in touch with
Apple Support if you need more help.

Before using Apple Diagnostics, disconnect any external devices, such as a hard disk or
external display. Be sure your MacBook Air is connected to the Internet.

To start Apple Diagnostics, restart your MacBook Air and hold down the D key as it starts
up. If prompted, select the language for your location. Press the Return key or click the
right arrow button. The basic Apple Diagnostics test takes a few minutes to complete. If
an issue is found, a description of the issue appears with additional instructions. Make a
note of any reference codes before you exit Apple Diagnostics.

Online resources. For online service and support information, go to 
. You can learn about Apple products, view online manuals, check for software

updates, connect with other Apple users, and get service, support, and professional
advice from Apple. For more information about your MacBook Air, see 

.

AppleCare support. If you need assistance, AppleCare representatives can help you
with installing and opening apps, and with troubleshooting. Call the support center
number nearest you (the first 90 days are complimentary). Have the purchase date and
your serial number ready when you call.

Mac tips for Windows switchers

Mac
keyboard shortcuts

Welcome to Apple
Support

MacBook Air
Support
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A complete list of support telephone numbers is available on the web at 
. Telephone numbers are subject to change, and local and national

telephone rates may apply.

Your 90 days of complimentary telephone support begins on the date of purchase.

Contact Apple
for support and service

Draft Apple proprietary and confidential

https://support.apple.com/HT201232


MacBook Air Essentials

Page 79 of 89

Important safety information
WARNING: Failure to follow these safety instructions could result in fire, electric

shock, or other injuries, or damage to your MacBook Air or other property. Read all safety
information below before using your MacBook Air.

Built-in battery. Donʼt attempt to replace or remove the battery yourself—you may
damage the battery, which could cause overheating and injury. The built-in battery
should be replaced by Apple or an authorized service provider, and must be recycled or
disposed of separately from household waste. Dispose of batteries according to your
local environmental laws and guidelines. Donʼt expose your MacBook Air to extreme heat
sources, such as radiators or fireplaces, where temperatures might exceed 212°F
(100°C).

For information about battery service and recycling, go to .

Handling. Handle your MacBook Air with care. It is made of metal, glass, and plastic and
has sensitive electronic components inside. Place your MacBook Air on a stable work
surface that allows for adequate air circulation under and around the computer. Your
MacBook Air can be damaged if dropped, burned, punctured, or crushed, or if it comes in
contact with liquids, oils, and lotions. Donʼt use a damaged MacBook Air, such as one
with a cracked screen, as it may cause injury.

Liquid exposure. Keep your MacBook Air away from sources of liquid, such as drinks,
oils, lotions, sinks, bathtubs, shower stalls, and so on. Protect your MacBook Air from
dampness, humidity, or wet weather, such as rain, snow, and fog.

Charging. Charge MacBook Air only with the included 30W USB-C Power Adapter, or
with a third-party power adapter and cable that are compatible with USB-C and
compliant with applicable international and regional regulations and safety standards,
including IEC 60950. Other adapters might not meet applicable safety standards, and
charging with such adapters could pose a risk of death or injury.

Using damaged cables or chargers, or charging when moisture is present, can cause fire,
electric shock, injury, or damage to your MacBook Air or other property. When you use
the included 30W USB-C Power Adapter to charge your MacBook Air, make sure the
USB-C Charge Cable (2m) is fully inserted into the power adapter before you plug the
adapter into a power outlet.

Safety, handling, and regulatory information

Battery Service and Recycling
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Prolonged heat exposure. Your MacBook Air and its 30W USB-C Power Adapter may
become very warm during normal use. The MacBook Air and its 30W USB-C Power
Adapter comply with applicable surface temperature standards and limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950-1).
However, even within these limits, sustained contact with warm surfaces for long periods
of time may cause discomfort or injury.

Use common sense to avoid situations where your skin is in prolonged contact with a
device or its power adapter when itʼs operating or plugged into a power source. For
example, donʼt sleep with a device or power adapter when itʼs plugged into a power
source. Donʼt operate your MacBook Air on a pillow, blanket, or other soft material that
can block ventilation openings. Itʼs important to keep your MacBook Air and its
30W USB-C Power Adapter in a well-ventilated area when in use or charging.

Never push anything into the ventilation openings, as doing so may be dangerous and
cause your computer to overheat. Never place anything over the keyboard when
operating your MacBook Air. If your MacBook Air is on your lap and gets uncomfortably
warm, remove it from your lap and place it on a stable, well-ventilated work surface. Take
special care if you have a physical condition that affects your ability to detect heat
against the body.

30W USB-C Power Adapter. To operate the 30W USB-C Power Adapter safely and
reduce the possibility of heat-related injury or damage, do one of the following:

Plug the 30W USB-C Power Adapter directly into a power outlet.

If youʼre using the Power Adapter Extension Cable, place the power adapter on a
desk, table, or on the floor in a well-ventilated location.

Donʼt use a power adapter in wet locations, such as near a sink, bathtub, or shower stall,
or connect or disconnect the power adapter with wet hands. Disconnect the power
adapter and any cables if any of the following conditions exists:

You want to clean the case (use only the recommended procedure, described in
).

The power cord or plug becomes frayed or otherwise damaged.

Your MacBook Air or 30W USB-C Power Adapter is exposed to rain, excessive
moisture, or liquid spilled into the case.

Your MacBook Air or 30W USB-C Power Adapter has been dropped, the case has
been damaged, or you suspect that service or repair is required.

Important handling information
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30W USB-C Power Adapter specifications:

Frequency: 50 to 60 Hz, single phase

Line Voltage: 100 to 240 Vac

(USB-PD) Output Voltage: 20 VDC / 1.5A, 15 VDC / 2A, 9 VDC / 3A, 5 VDC / 3A

Take special care if you have a physical condition that affects your ability to detect heat
against the body.

Hearing loss. Listening to sound at high volumes may damage your hearing. Background
noise, as well as continued exposure to high volume levels, can make sounds seem
quieter than they actually are. Use only compatible earbuds, headphones, or earpieces
with your MacBook Air. Turn on the audio and check the volume before inserting anything
into your ear. For more information about hearing loss, see .

WARNING: To prevent possible hearing damage, do not listen at high volume levels
for long periods.

Repairing. Your MacBook Air doesnʼt have any user-serviceable parts. Do not open or
disassemble MacBook Air or attempt to repair it or replace any components.
Disassembling your MacBook Air may damage it or may cause injury to you. If your
MacBook Air needs service, is damaged, malfunctions, or comes in contact with liquid,
contact Apple or an Apple-authorized repair center, such as an Apple Authorized Service
Provider. If you attempt to open your MacBook Air, you risk damaging your computer, and
such damage isnʼt covered by the limited warranty on your MacBook Air.

Navigation. Maps, directions, and location-based apps depend on data services. These
data services are subject to change and may not be available in all areas, resulting in
maps, directions, or location-based information that may be unavailable, inaccurate, or
incomplete. Compare the provided location-based information to your surroundings and
defer to posted signs to resolve any discrepancies. Do not use these services while
performing activities that require your full attention. Always comply with posted signs and
the applicable laws and regulations in the areas where you are using navigation, and
always use common sense.

Radio frequency exposure. MacBook Air uses radio signals to connect to wireless
networks. For information about radio frequency (RF) energy resulting from radio signals
and steps you can take to minimize exposure, see .

Medical device interference. MacBook Air contains components and radios that emit
electromagnetic fields, including magnets, which may interfere with pacemakers,
defibrillators, and other medical devices. Maintain a safe distance between your medical

Sound and Hearing

RF Exposure
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device and MacBook Air. Consult your physician and medical device manufacturer for
information specific to your medical device. If you suspect MacBook Air is interfering with
your pacemaker or any other medical device, stop using MacBook Air.

Medical conditions. If you have a medical condition that you believe could be affected
by using MacBook Air (for example, seizures, blackouts, eyestrain, or headaches),
consult with your physician prior to using MacBook Air.

Repetitive motion. When you perform repetitive activities such as typing or playing
games on MacBook Air, you may experience discomfort in your hands, arms, wrists,
shoulders, neck, or other parts of your body. If you experience discomfort, stop using
MacBook Air and consult a physician.

Choking hazard. Some MacBook Air accessories may present a choking hazard to small
children. Keep these accessories away from small children.

High-consequence activities. Your MacBook Air is not intended for use where the
failure of the computer could lead to death, personal injury, or severe environmental
damage.

Explosive and other atmospheric conditions. Using MacBook Air in any area with a
potentially explosive atmosphere may be hazardous—particularly in areas where the air
contains high levels of flammable chemicals, vapors, or particles such as grain, dust, or
metal powders. Exposing MacBook Air to environments having high concentrations of
industrial chemicals, including evaporating liquified gases such as helium, may damage
or impair MacBook Air functionality. Obey all signs and instructions.

Important handling information
Operating environment. Operating your MacBook Air outside these ranges may affect
performance:

Operating temperature: 50° to 95° F (10° to 35° C)

Storage temperature: -13° to 113° F (-25° to 45° C)

Relative humidity: 0% to 90% (noncondensing)

Operating altitude: Tested up to 10,000 feet (0 to 3048 meters)

Carrying your MacBook Air. If you carry your MacBook Air in a bag or briefcase, make
sure there are no loose items (such as paper clips or coins) that could accidentally get
inside the computer through vent openings or get stuck inside the USB-C ports.
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Using connectors and ports. Never force a connector into the USB-C ports. When
connecting a device, make sure the port is free of debris, that the connector matches the
port, and that you have positioned the connector correctly in relation to the port.

Using the USB-C Charge Cable (2m). Certain usage patterns can contribute to the
fraying or breaking of cables. The USB-C Charge Cable, like any other metal wire or
cable, is subject to becoming weak or brittle if repeatedly bent in the same spot. Aim for
gentle curves instead of angles in the cable. Regularly inspect the cable and connectors
for any kinks, breaks, bends, or other damage. Should you find any such damage,
discontinue use of the USB-C Charge Cable.

Storing your MacBook Air. If you are going to store your MacBook Air for an extended
period of time, keep it in a cool location (ideally, 71° F or 22° C) and discharge the battery
to 50 percent. When storing your computer for longer than five months, maintain the
capacity of the battery by charging the battery to 50 percent every six months or so.

Cleaning your MacBook Air. When cleaning the outside of your MacBook Air and its
components, first shut down your MacBook Air, then unplug the 30W USB-C Power
Adapter. Then dampen a clean, soft, lint-free cloth to wipe the MacBook Air exterior.
Avoid getting moisture in any openings. Donʼt spray liquid directly on the computer. Donʼt
use aerosol sprays, solvents, abrasives, or cleaners containing hydrogen peroxide that
might damage the finish.

Cleaning the MacBook Air screen. To clean the MacBook Air screen, first shut down
your MacBook Air and unplug the 30W USB-C Power Adapter. Dampen a clean, soft, lint-
free cloth with just water and wipe the screen. Donʼt spray liquid directly on the screen.

Understanding ergonomics
When you use the keyboard and mouse, your shoulders should be relaxed. Your upper
arm and forearm should form an angle that is slightly greater than a right angle, with your
wrist and hand in roughly a straight line.

Use a light touch when typing or using the trackpad and keep your hands and fingers
relaxed. Avoid rolling your thumbs under your palms.
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Change hand positions often to avoid fatigue. Some computer users might develop
discomfort in their hands, wrists, or arms after intensive work without breaks. If you begin
to develop chronic pain or discomfort in your hands, wrists, or arms, consult a qualified
health specialist.

External mouse. If you use an external mouse, position the mouse at the same height as
the keyboard and within a comfortable reach.

Chair. An adjustable chair that provides firm, comfortable support is best. Adjust the
height of the chair so your thighs are horizontal and your feet are flat on the floor. The
back of the chair should support your lower back (lumbar region). Follow the
manufacturerʼs instructions for adjusting the backrest to fit your body properly.

Built-in display. Adjust the angle of the display to minimize glare and reflections from
overhead lights and windows. Do not force the display if you meet resistance. The display
is not designed to open past 135 degrees.

You can adjust the brightness of the screen when you take the computer from one work
location to another, or if the lighting in your work area changes.

For more information about ergonomics, see .

Regulatory information
Regulatory information, certification, and compliance marks specific to MacBook Air are
available on-device. Choose Apple menu  > About This Mac > Support > Regulatory
Certification.

FCC compliance statement
This device complies with part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) This device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause undesired
operation.

Ergonomics

Draft Apple proprietary and confidential

http://www.apple.com/about/ergonomics


MacBook Air Essentials

Page 85 of 89

Note: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that interference will not occur in
a particular installation.

If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment to an outlet on a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

Important: Changes or modifications to this product not authorized by Apple could void
the electromagnetic compatibility (EMC) and wireless compliance and negate your
authority to operate the product.

This product has demonstrated EMC compliance under conditions that included the use
of compliant peripheral devices and shielded cables between system components. It is
important that you use compliant peripheral devices and shielded cables between system
components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices.

If necessary, contact Apple or take your MacBook Air to an Apple Authorized Service
Provider. Or consult an experienced radio/television technician for additional suggestions.

Responsible party (contact for FCC matters only):
Apple Inc.
One Apple Park Way, MS 911-AHW
Cupertino, CA 95014
USA
www.apple.com/contact
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ISED Canada regulatory compliance
This device complies with Innovation, Science and Economic Development Canada
license-exempt RSS standard(s). Operation is subject to the following two conditions: (1)
this device may not cause interference, and (2) this device must accept any interference,
including interference that may cause undesired operation of the device.

Operation in the band 5150–5250 MHz is only for indoor use to reduce the potential for
harmful interference to co-channel mobile satellite systems.

Le présent appareil est conforme aux CNR dʼInnovation, Sciences et Développement
économique Canada applicables aux appareils radio exempts de licence. Lʼexploitation
est autorisée aux deux conditions suivantes : (1) lʼappareil ne doit pas produire de
brouillage, et (2) lʼutilisateur de lʼappareil doit accepter tout brouillage radioélectrique
subi, même si le brouillage est susceptible dʼen compromettre le fonctionnement.

La bande 5150–5250 MHz est réservée uniquement pour une utilisation à lʼintérieur afin
de réduire les risques de brouillage préjudiciable aux systèmes de satellites mobiles
utilisant les mêmes canaux.

EU compliance statement
Apple Inc. hereby declares that this wireless device is in compliance with Directive
2014/53/EU.

A copy of the EU Declaration of Conformity is available at .

Appleʼs EU representative is Apple Distribution International, Hollyhill Industrial Estate,
Cork, Ireland.

Use Restriction

This device is restricted to indoor use when operating in the 5150 to 5350 MHz
frequency range. This restriction applies in: AT, BE, BG, CH, CY, CZ, DE, DK, EE, EL, ES,
FI, FR, HR, HU, IE, IS, IT, LI, LT, LU, LV, MT, NL, NO, PL, PT, RO, SE, SI, SK, TR, UK.

Declarations of Conformity
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Japan VCCI Class B Statement

ENERGY STAR® Compliance Statement

As an ENERGY STAR partner, Apple has determined that standard configurations of this
product meet the ENERGY STAR guidelines for energy efficiency. The ENERGY STAR
program is a partnership with electronic equipment manufacturers to promote energy-
efficient products. Reducing energy consumption of products saves money and helps
conserve valuable resources.

MacBook Air is shipped with power management enabled, with the computer set to sleep
after 10 minutes of user inactivity. To wake your computer, click the trackpad or press any
key on the keyboard. To change this setting, click the System Preferences icon  in the
Dock, then click Energy Saver.

For more information about ENERGY STAR, go to .

Apple and the environment
At Apple, we recognize our responsibility to minimize the environmental impacts of our
operations and products.

For information, go to Appleʼs  website.

Energy Star

Environment
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Disposal and recycling information

This symbol indicates that this product and/or battery should not be disposed of with
household waste. When you decide to dispose of this product and/or its battery, do so in
accordance with local environmental laws and guidelines.

For information about Appleʼs recycling program, recycling collection points, restricted
substances, and other environmental initiatives, go to Appleʼs  website.

Información sobre eliminación de residuos y reciclaje

El símbolo de arriba indica que este producto y/o su batería no debe desecharse con los
residuos domésticos. Cuando decida desechar este producto y/o su batería, hágalo de
conformidad con las leyes y directrices ambientales locales. Para obtener información
sobre el programa de reciclaje de Apple, puntos de recolección para reciclaje, sustancias
restringidas y otras iniciativas ambientales, visite  o 

.

Brasil – Informações sobre descarte e reciclagem

O símbolo acima indica que este produto e/ou sua bateria não devem ser descartados no
lixo doméstico. Quando decidir descartar este produto e/ou sua bateria, faça-o de acordo
com as leis e diretrizes ambientais locais. Para informações sobre substâncias de uso
restrito, o programa de reciclagem da Apple, pontos de coleta e telefone de informações,
visite .

European Union—Disposal Information

The symbol above means that according to local laws and regulations your product
and/or its battery shall be disposed of separately from household waste. When this
product reaches its end of life, take it to a collection point designated by local authorities.
The separate collection and recycling of your product and/or its battery at the time of
disposal will help conserve natural resources and ensure that it is recycled in a manner
that protects human health and the environment.

Battery disposal information

The battery in your MacBook Air should be serviced, replaced, or recycled by Apple or an
authorized service provider, and must be recycled or disposed of separately from
household waste according to your local environmental laws and guidelines. For
information about battery service and recycling, go to .

Environment

Medio ambiente Si damos más de
nosotros, tomamos menos del planeta

Meio ambiente

Battery Service and Recycling
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Software License Agreement
Use of MacBook Air constitutes acceptance of the Apple and third-party software license
terms found at .

Apple Inc.

© 2018 Apple Inc. All rights reserved.

Use of the “keyboard” Apple logo (Option-Shift-K) for commercial purposes without the prior written consent
of Apple may constitute trademark infringement and unfair competition in violation of federal and state laws.

Apple, the Apple logo, AirDrop, AirPlay, AirPods, AirPort, AirPrint, Apple Music, Apple Pay, Apple TV,
Apple Watch, Face ID, FaceTime, Finder, Flyover, GarageBand, Handoff, iMovie, iPad, iPhone, iPod touch,
iTunes, iTunes U, Keynote, Launchpad, Lightning, Mac, MacBook, MacBook Air, macOS, Mission Control,
Numbers, Pages, Retina, Safari, Siri, Spaces, Spotlight, Time Machine, Touch ID, and watchOS are
trademarks of Apple Inc., registered in the U.S. and other countries.

Apple Books, Live Photos, and tvOS are trademarks of Apple Inc.

AppleCare, Apple Store, App Store, iCloud, iTunes Radio, and iTunes Store are service marks of Apple Inc.,
registered in the U.S. and other countries.

Apple

One Apple Park Way
Cupertino, CA 95014
USA

IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of
such marks by Apple Inc. is under license.

ENERGY STAR and the ENERGY STAR mark are registered trademarks owned by the U.S. Environmental
Protection Agency.

Other company and product names mentioned herein may be trademarks of their respective companies.

Every effort has been made to ensure that the information in this manual is accurate. Apple is not responsible
for printing or clerical errors.

Some apps are not available in all areas. App availability is subject to change.

Software License Agreements

www.apple.com
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